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PERCEPTION NEURON is the world’s most versatile, adaptable and affordable 
motion capture system offering user-friendly technology for various applications.

PERCEPTION NEURON can be used for different applications in the fields of 
VFX, game interaction, virtual reality, sports analysis, medical analysis and real-
time stage performance among others.

1.	 VFX: Motion recording and replaying; BVH and FBX format output 
supported for Maya, MotionBuilder, Blender, etc. 

2.	 VR / Game interaction: Seamless integration with HMD with opensource 
game engine demos; Gesture control library included; Bring ‘yourself’ into 
the virtual world. 

3.	 Sports / Medical Analysis: Get all orientation, position, and raw acc and 
gyro data flow in real-time; free ‘Data-Visualizer’ for data plotting and 
recording/comparison. 

4.	 Stage performance: Real-time data stream output; Wireless data 
transmission.
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Overview

Perception 
Neuron

Welcome to



The Perception Neuron motion capture system needs to communicate with the 
Axis Neuron software. Axis Neuron can receive and process the motion data 
and export it to a third-party software. It is also possible to do synchronous 
broadcasting with a third-party software. In addition, you can get the high-quality 
motion data which is compatible with most professional film effects and game 
development tools.

Are you ready? The following content is designed to quickly get you up and 
running with Axis Neuron.

Perception Neuron uses 
an IMU sensor (Inertial 
Measurement Unit) composed 
of accelerometer, gyroscope and 
magnetometer.

The Hub compiles and 
synchronizes all motion data 
and broadcasts it to the 
computer via USB or Wifi.

The strap is worn on the body and 
contains the Perception Neuron 
sensor. The back label tells you 
where it should be worn.

AXISNEURONUSERGUIDE
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2.1 Equipment: Brief Introduction

PERCEPTION NEURON SENSOR HUB STRAP

QuickStart
2.
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2.

QuickStart

After properly fitting the straps and sensors, launch Axis Neuron. Let’s begin 
recording our first motion data.

Connect the Hub to the computer with the USB data cable (black). One side of 
the USB cable connects to the Hub’s data port and the other side connects to 
an open USB port on the computer.

If the Hub was recognized successfully, the Hub ID will be shown in the device 
list in the left panel of the Welcome window. Click the Connect button to connect 
the Hub with the computer. 

2.2 Capture Motion Data

1.



AXISNEURONUSERGUIDE

7

After successfully establishing a connection with the Hub, click the zero button to 
move the model to the origin of the coordinate system (keep steady and do not 
move during this procedure.)

Choose a body size for the model in the Body Dimension list to ensure a more 
accurate capture.

QuickStart

3.

4.
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Click the Calibrate button to perform the posture calibration. This calibration step 
helps Axis Neuron understand the placement and orientation of the sensors on 
the actor to increase the accuracy of the motion data.

Click Deselect all and select only the Steady Pose option. During the calibration 
you must keep all sensors and straps steady (no special requirement to the 
posture). Try to sit down, put your hands on a table and then click Next. The 
Steady Pose calibration removes bias errors brought by the connection between 
Perception Neuron Sensors and the socket.
Perform this pose only once until you reposition the Perception Neuron sensor,
or introduce  new sensors.

QuickStart

6.

5.



AXISNEURONUSERGUIDE

9

After succcesfully completing the Steady Pose, reopen the Posture Calibration 
window and check the remaining pose(s) that need to be calibrated then click 
Next to start calibration. (Available poses depend on the working mode selected 
in the Sensor Map). 

QuickStart

7.

You can start recording after the posture calibration is complete. Click the Record 
button then choose a path for saving the recorded data and the record File Name 
in the pop up window. 
(The motion data is then recorded immediately after you click on the OK button).8.
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To stop recording click on the Record button again. The recorded file will now 
appear in the Working Directory window.

9.

Once recording has ended the motion data is now ready for review. Select the 
recorded file generated in the Working Directory window and click the Play 
button. You will see the motion you recorded on the Axis Neuron viewport.

10.

QuickStart
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Export your motion data by clicking  File> Export. On the Export settings window 
click Export after you have selected the desired file format. For this example we 
chose the default recorded file <bvh> format.11.

QuickStart
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1.   Environment
It is strongly suggested to use your Perception Neuron system in an enviroment 
with little to no magnetic field. Otherwise the sensors will be adversely influenced 
making the motion captured data extremely imprecise. Avoid electric motors, 
loudspeakers, transformers, and furniture.

Perception Neuron should NOT be used in a environment with strong magnetic 
interferences. Using the system in such an environment introduces significant 
errors to the motion capture results. Exposing Neurons to such an environment 
for a long time will cause sensor magnetization.
The container that comes with the Neurons is made of special material which 
can effectively isolate magnetic field and therefore prevent sensor magnetization. 
Neurons should be placed in this container during transportation, long-term 
storage, or when situated in any environment with magnetic interferences.

QuickStart

2.3 Caution & Tips
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QuickStart

2.   Improving precision 
Accurate skeletal measurement and size can improve the precision of the motion 
data. If you want to acheive more accurate data, measure your actor’s specified 
body parts and input this data into the Body Size Manager before recording. The 
measuring will be introduced in a later chapter.
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Software 
Interface 
Introduction

Software Interface Introduction

3.
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Software Interface Introduction

3.1 Guide

1.	 Menu Bar - File, Window, Tools, and Help access.

2.	 Title - Display name of the current active file.

3.	 Sensor Map - Displays the data transmission signal strength from the sensors.

4.	 Scene View Navigation - Toggle view for the grid, center of gravity, shadow,                    

origin reference. Parent camera to the actor.                     

5.	 Motion Catpure Bar - Record, Connect, Disconnect, Calibrate, Zero.

6.	 Viewport - View playback or live motion data on this window.

7.	 Contact Editing - This area contains tools to clean up contact points. 

8.	 Range Settings - You can set the frame range of the animation.

9.	 Play Controller - Basic control of playing.

10.	Working Directory - Displays a list of captured files from a user specified         	

folder.

11.	Status Bar - Show status.

12.	Editing Panel - The parameters and other functional settings panel.
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3.2 Menu Bar
3.2.1 File

Interface Tips:

1.   To show or hide any panel navigate to Window –> Panels or right click the 
title bar of any panel and then check the one you want to see.
 
2.   To reset the current layout navigate to Window –>  Layout and there are 
several default layouts available.
 
3.   Move any panel to anywhere you want by dragging the title bar of the panel. 
By double clicking on the title bar of the panel you can toggle the panel view 
between floating mode and docking mode. 

Options availabe include Open File, Open Directory, Settings, Export and Exit

1.   Open File: Open an existing file (.raw format)
2.   Open Directory: Displays files from a folder location.
3.   Recent File & Recent Directory display recently opened files and folders.

Software Interface Introduction
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2. Settings
2.A General: 
Displays the Host IP and Port.

2.B   Output Format:
BVH Data
Displacement: Checking this box will affect the real-time model, the Data 
Visualizer panel, and the real-time data broadcast. BVH data with displacement 
will include 6 floats for each and every 59 bones: 3 for the displacements (X Y Z) 
and 3 for rotation data (Default rotation order is Y X Z). For the BVH data without 
displacement, except the root node (Hip) having displacement and rotation, other
bones will only stream rotation data. There are some third-party softwares (e.g 3ds 
Max) that do not support bone displacement. Disabling the displacement in the 
data stream will result in the legs not being straight because of no displacement 
data present.

Software Interface Introduction
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2.C   Advanced:
Contact Optimization Level: This option calculates auto-optimization on the 
original contact relationship data. The default value is 2. 

Gyro Mode: 
Auto detect: According to different magnetic field enviroments, this option will 
automatically adust the working mode (9-Axis or 6-Axis). When the system 
detects a high-intensity magnetic field, the LEDs of the sensors will always be 
on and the gyro will switch to 6-Axis mode. It will not calculate the magnetic 
data to assure that the motion capture data won’t be influenced by the high-
intensity magnetic field. When the actor moves to a low-intensity magnetic 
field enviroment, the gyro will switch back to 9-Axis mode and the LEDs of the 
Perception Neuron Sensors will be in their normal state again.

Manual mode: you can adjust the gyro mode manually by choosing 6 or 9   
axis.

Frequency reducing: Change the frequency frame output for streaming. By 
default the value is set to 1, data will stream every frame per second. The user 
can choose to stream half of the motion data by selecting 1/2. 
Rotation: Select the desired World Space Axis for streaming.
Reference: In order to translate or rotate the entire skeleton without changing the 
data of the bones in the skeleton, a new node, regarded as the parent node of the 
root node, could be added in the BVH data structure.

Calculation Data
For Calculation Data, the data of each bone has a total of 16 float data points 
consisting of position (X Y Z with global coordinate), velocity (X Y Z with 
global coordinate), sensor quaternion (W X Y Z with global coordinate), sensor 
accelerated velocity (X Y Z with module’s coordinate) and gyro (X Y Z with 
module’s coordinate). The user can choose between local or global data stream 
for the output.

Software Interface Introduction
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3.   Export: 
Provides options for exporting data from Axis Neuron.

•	 Rotation: The rotation order of the Euler angle based on the 3D software you 
wish to export to. The default order is YXZ. 

•	 Displacement: Determines if the exported file contains displacement data.
•	 Character List: Choose which character to export when working in Multiplay 

Mode.

2.D   Broadcasting: 
Choose the Internet Protocol and the file format.

Software Interface Introduction
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3.2.2 Window

The layout can be adjusted through this menu and panels can be shown or hidden .

1.   Layout
There are several layouts that you can choose. They are Full Fuction mode, 
Editing mode, Capture mode, Replay and Demo mode. Additionally, you can 
make a custom layout by choosing New Layout.

•	 Full Function - Displays all windows needed for recording and editing.

Software Interface Introduction
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•	 Editing layout - Similar to Full Function with slightly different window space 
configuration.

•	 Capture layout - Closes the Contact editing window as this is not needed 
during the capture phase.

Software Interface Introduction
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•	 Replay and Demo - Maximizes the viewport window screen space.

2.   Panels: 
Show or hide specific panel.

3.   Motion Capture Toolbar:
Show or hide the Motion Capture Toolbar. Following are the descriptions of the 
operations shown in the Motion Capture Toolbar. 

Software Interface Introduction
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•	 The red button means Record. 

•	 The R button means Calibrate. 

•	 The L button means Eliminate error.

•	 Record: When this button is clicked, the 
Record settings dialog will pop up. You can 
change the storage path and file name here. 
When you click “ok”, the red light will blink 
and Recording will start. Click “Record” 
again and the recording will stop. The new 
raw file will show in the Working Directory. 

•	 Connect: Before you start recording, 
you need to connect the suit to the Axis 
Neuron software. Once you click this 
button, you can choose the device you 
want to connect from the equipment list. 
Multiple devices (suits) will be available 
if you are using more than one suit. 

•	 Disconnect: Clicking this button will 
disconnect the device(s) from Axis Neuron. 

•	 Calibrate:  This button will start the pose 
calibration processto improve capture 
accuracy. 

•	 Eliminate error:  This button will align the 
actor with the origin of the Workspace. 
When the sensors capture a lot of out-of-
range motions, the sensor accuracy may 
become imprecise. Click Zero to minimize 
these errors. After clicking the button, the 
Keep Steady radar will display and the actor 
should remain steady during this period. 

•	 Shutter: The Shutter is the remote 
controller. Clicking this button will open the 
shutter function. Clicking it again will close 
this function. Before using the Shutter, 
please plug the receiver into an open  
USB port.

Software Interface Introduction
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4.   Scene View Toolbar: Toggle layer visibility assets on 
the viewport

TIPS

•	 View - Various viewport layouts can be 
chosen from here. Each view can show 
any angle of the model. When setting 
multiple views, you can drag the separation 
line of the two views to resize them. 

•	 The shortcut of full screen is Ctrl+F. 
Quit full screen is Ctrl+F or Esc. 

•	 Click with the left mouse button on the 
view that you want to be active. Pressing 
and holding the left mouse button will 
move the camera view (pan). Pressing and 
holding the right mouse button will rotate 
the camera view (orbit). Rolling the mouse 
wheel will adjust the distanace between 
the camera and the model (dolly).

Software Interface Introduction
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•	 Background: Toggle ground plane visibility. 

•	 Camera Track: Parents the viewport 
camera position to the avatar making model 
remain at the center of interest. 
 

•	 Center of Mass: Displays or hides the 
center-of-mass of the model. 

•	 Shadow: Toggle shadow visibility.  
 

•	 Origin Marker: Shows or hides the red 
cross marker indicating the origin of scene.

Center of mass

Origin Marker

Shadow

Scene View Toolbar Introduction

Software Interface Introduction
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3.2.3 Tools

3.2.4 Help

TIPS

•	 Details on the calibration process can be found 
in 10.2 Perception Neuron Calibration.

•	 The differences between Pose Calibration and 
Sensor Calibration:

Pose Calibration: This calibration is for 
holistic posture when an actor is wearing the 
equipment.

Sensor Calibration: This calibration is for 
eliminating the accumulated error of the 
single magnetized sensor.

 

Calibrate Sensor: Calibrates the magnetized Perception Neuron sensors 
to eliminate accumalated errors. This operation requires that the tool cable is 
plugged into the hub and the hub is connected to the computer via USB.

Upgrade: Manually upgrade the firmware of the Hub app, Hub Boot, Perception 
Neuron app, or Perception Neuron boot to the latest version. 
Additionally the software will always auto check the version of the firmware  
as well.

Open Folder: Opens the Body Size Files or Demo File Folder.

Software Interface Introduction
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3. Working Mode Reference Diagram: Introduction on the motion capture            	
    wearing modes. 

Reset: Contains options for resetting various parameter categories
•	 Settings: Resets all settings to their default.
•	 Current Character: Resets the Data parameters of the current  

character (including model alightment, Parameter, Body Size  
Manager, Smooth Factor, and Data Visualizer).

•	 Layout: Reset the layout.

Working Mode Reference Diagram: Provides reference to the motion capture 
wearing modes.

Software Interface Introduction
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Connection and Calibration

Connection & 
Calibration

4.

The Perception Neuron Sensors are capable of 60/120 fps sampling rate. All of the 
sensors will send the data to the Hub and the Hub will send the data to the computer 
via USB or wireless connectivity. This chapter will outline these two methods of 
connection and pose calibration.
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Connection and Calibration

4.1 USB connection
There are 2 ways to establish a connection via USB.

Method One: Using the Connect button in the Motion Capture toolbar and 
choosing the device from the Equipment List window.
1. Plug the USB cable into the Hub using the data port connection and connect 
the other side of the USB cable into an available USB port on the computer.
2. Click the Connect button in the Motion Capture toolbar.

3.  Click Connect in the Equipment list pop up Window.
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BEST QUALITY

MID QUALITY

BAD QUALITY

NO SIGNAL: NO DATA

•	 When you create a real-time connection,	
the sensor map will show the transmission 
quality of the data. 

•	 It is normal for sensor quality to toggle from 
green to yellow. However, a red constant 
light indicates trouble.

TIPS

Method Two: Using the Connect button in the Welcome window.
1. Plug the USB cable into the Hub using the Data port connection and connect 
the other side of the USB cable into an available USB port on the computer.
2. Click Window -> Welcome, and click Connect on the left side of the screen.

Connection and Calibration
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To establish a wireless connection to a router, Axis Neuron requires the Hub to 
be connected directly to the computer. The Perception Neuron Hub supports any 
standard 2.4G router.

•	 Set up your router: Set the router’s SSID and password. (The lengh of SSID 
needs to be less than 26 characters. The length of the password needs to be 
less than 17 characters.)

•	 Connect the computer to the router via an ethernet cable.
•	 Plug the USB cable into the Hub’s data port and connect the other end of the 

USB cable into an available USB port on the computer.
•	 Click the Connect button from the Motion Capture toolbar.

•	 In the Equipment list dialogue click on Setup.

4.2 Wireless Connection

Connection and Calibration
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•	 Click Next.

•	 Click the SSID you want to connect to and input the password.

Connection and Calibration
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7.   Unplug the USB data cable from the computer. Switch the USB cable attached 
to the Hub from the data port to the 5V/2A IN port on the Hub then connect the 
other end of the USB cable to a portable USB power supply. Click Finish to close 
dialog. Wait until the Hub establishes a connection with the router. This should 
not take more than 20 seconds. The Hub will send out a buzzing sound one time 
to show a successful connection.

8.   Click Connect button. 

TIPS

•	 If the SSID you want to connect is not on 
the list,  you can also click the Manual 
input to refresh the SSID manually. 
 

•	 The Hub will store the SSID and password 
you set. So, if the Host IP doesn’t change, 
you can skip setting the password step by 
clicking the Skip button.

Connection and Calibration
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Axis Neuron supports up to five Perception Neuron suits connected simultaniously. 
The method of connection is the same as the single equipment connection. To 
connect multiple actors the connection must be done one at a time.

This four-step posture calibration process is required before you start to record 
motion data. Please read the following introduction about calibration carefully. 
You can also find this information in the Quick Start guide.

4.3 Multiple Equipment Connection

4.4 Posture Calibration

Connection and Calibration
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Steps: 
1.   After connecting successfully, click the Calibrate button in the Motion 
Capture toolbar. 

2.   Click Next in the posture selection dialog then perform the Steady pose. 
A (3) second countdown will begin followed by 15 consecutive beeps during 
the calibration. (You only need to do this calibration once until you re-allocate 
the Perception Neuron sensors on your body straps/gloves as this calibration 
removes the bias error brought by the connection between the sensors and the 
socket).

3.   When performing the Steady Pose calibration the actor must remain still. We 
recommend having the actor remain in a sitting position.

Connection and Calibration
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4.   Once the Steady Pose is complete reopen the posture calibration window 
and select A, T, S pose. (Available pose will depend on the working mode.)

4.1.   A Pose calibration - During the countdown, the actor will have time to 
postion his/her body for the correct posture. Place hands on the side of the thigh 
and keep feet parallel. The Upper Arm Strap should be parallel to the palm sensor 
in a single line chain.

Connection and Calibration
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4.3.   S Pose calibration - Bend the knees and position your body in the letter ‘S’. 
Maintain your back upright perpendicular to the floor. Move your arms in front of 
you and position them parallel to the floor.  

4.2.   T Pose calibration - Arms need to be extended out parallel to the floor. 
The actor should not shuffle their feet between the posture calibration positions. 
Hands should be a little over-extended with the thumb facing 45 degrees out and 
45 degrees down (see image).

Connection and Calibration
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TIPS

•	 Having a second person supervise your 
calibration poses is advised. 

•	 Feet must remain parallel, do not shuffle your 
feet during all posture calibrations. 

•	 Knees on the S-Pose are to be parallel to 
your feet. 

•	 If you find the avatar is having issues with a 
closed fist, then we suggest to over extend 
the hand during the T Pose.

Notes:
1.   When the working mode is set to  Single arm or Upper Body mode, the S-pose 
is not required. When the mode is set to Lower body, the T-pose calibration is not 
required.

SINGLE ARM MODE

Connection and Calibration
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2.   The Posture calibration will need to be performed again if the body size has 
been changed for the avatar.

3.  When equipped with the full finger gloves, during the T-pose calibration 
pay attention to the position of the thumb. The actor must position the thumb 
45 degrees from the palm in the top view and left view.	

UPPER BODY MODE

LOWER BODY MODE

Connection and Calibration



AXISNEURONUSERGUIDE

40

4.   During the steady pose, calibration it is not necessary to put the Perception 
Neuron suit on the actor. The Perception Neuron suit can be placed on a flat 
secured surface during the steady pose, improving sensor stability during this 
calibration step. It is important to keep the Perception Neuron sensors stable as 
much as possible otherwise Axis Neuron will show an error hint. If you see a red 
spot, this means that Perception Neuron’s steady pose calibration failed. You can 
click Retry to recalibrate it.

5. If the enviroment causes interference after the Posture Calibration has been 
performed, you may consider elevating the actor with the suit off the ground 
during the calibration to improve capture accuracy. This will elimate feet sliding 
and finger curling which is caused by ground or enviroment interference.

Connection and Calibration
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Sensor Wear Combination Mode

Sensor Wear 
Combination 
Mode

5.
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Perception Neuron allows you to change working mode based on the body 
segments needed. If accuracy is not essential, users have the flexibility to connect 
the most necessary sensors allowed. The image below shows an example of how 
to read the different working mode diagrams.

5.1 Working Mode Introduction

Necessary node

Unnecessary node

Sensor Wear Combination Mode
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Full body (Necessary Sensors: Both L/R - Upper Arm and Lower Arm, Hip, Spine, Upper Leg and Lower Leg.)

5.1.1 Full Body Mode

FULL BODY

•	 17-NEURON
•	 HUB 
•	 USB 
•	 BODY STRAPS
•	 GLOVES •	 31-NEURON

•	 HUB 
•	 USB 
•	 BODY STRAPS
•	 GLOVES

•	 21-NEURON
•	 HUB
•	 USB
•	 BODY STRAPS
•	 GLOVES

•	 11-NEURON
•	 HUB
•	 USB
•	 BODY STRAPS
•	 GLOVES

FULL BODY 
(DOUBLE HANDS AND 

FINGERS)

FULL BODY 
(SINGLE HAND ALL 

FINGERS)

FULL BODY
(NO PALM)

Sensor Wear Combination Mode
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Sensor Wear Combination Mode
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Single Arm (Necessary mode: Both L/R - Upper Arm and Lower Arm.)

5.1.2 Single Arm Mode

SINGLE ARM

•	 9-NEURON
•	 HUB 
•	 USB 
•	 TOOL LINE/ 

BODY STRAPS
•	 GLOVES

•	 6-NEURON
•	 HUB 
•	 USB 
•	 TOOL LINE/ 

BODY STRAPS
•	 GLOVES

•	 10-NEURON
•	 HUB 
•	 USB 
•	 TOOL LINE/ 

BODY STRAPS
•	 GLOVES

•	 3-NEURON
•	 HUB 
•	 USB 
•	 TOOL LINE/

BODY STRAPS
•	 GLOVES

SINGLE ARM

SINGLE ARM

SINGLE ARM

Sensor Wear Combination Mode
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Upper Body (Necessary mode: Both L/R - Upper Arm + Lower Arm, Hip, Spine.)

5.1.3 Upper Body Mode

UPPER BODY

•	 21-NEURON
•	 HUB
•	 USB 
•	 BODY STRAPS
•	 GLOVES •	 6-NEURON

•	 HUB
•	 USB 
•	 BODY STRAPS
•	 GLOVES

•	 25-NEURON
•	 HUB
•	 USB 
•	 BODY STRAPS
•	 GLOVES

•	 11-NEURON
•	 HUB
•	 USB 
•	 BODY STRAPS

UPPER BODY

UPPER BODY
(ALL FINGERS)

UPPER BODY

Sensor Wear Combination Mode



AXISNEURONUSERGUIDE

47

Sensor Wear Combination Mode
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Lower Body (Necessary mode: Hip, both L/R Upper Leg and Lower Leg.)

The socket straps with the labels Extra 1 and Extra 2 are known as universal 
straps. If a body strap on the suit is found to have a connection problem you may 
use one of the universal straps to replace the bad strap. A universal strap cannot 
replace any of the UPPER BODY STRAPS, GLOVES, or the HEAD STRAP. Both 
Extra 1 and Extra 2 can be used simultaneously. 

5.1.4 Lower Body Mode

5.2 Universal Straps

•	 5-NEURON
•	 HUB
•	 USB 
•	 BODY STRAPS

•	 7-NEURON
•	 HUB
•	 USB 
•	 BODY STRAPS

LOWER BODY

LOWER BODY

Extra

1
Extra

2

Sensor Wear Combination Mode
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FAQs:
1.   Condition: Using the extra device as right upper arm in a 3-Neuron single arm 
mode. 

When establishing the connection with Axis Neuron, the software will check the 
position of the universal strap sensor and prompt you whether the placement of 
the device was mapped correctly. If the universal strap was mapped incorrectly 
by the software, then the user has the option to drag the node to the correct 
position by using the diagram.
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2.   Condition: Extra 1 and Extra 2 used together in a 28-Neuron upper body 
mode with positions at right upper arm and left upper arm. 

This scenario will generate the same prompt dialog.

3.   Condition: Using the extra device as the left upper arm in a 30-Neuron Single 
Arm/ Upper Body mode and no sensor at right upper leg. In this scenario, the 
software will automatically detect the extra device on the right upper leg to match 
Full Body Mode and you will need to drag it to the right position manually.
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5.3 Attention
If the sensors that are detected by the system can not satisfy the necessary nodes 
of the corresponding working mode, the system will automatically set the working 
mode to any qualified working mode. If there is no matching working mode found, 
the system will inform you which necessary nodes are lacking sensors. The red 
spots show the positions that require a sensor for the necessary nodes.
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Data Editing

Data Editing
6.
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6.1 Model Alignment

You can adjust the following posture angle to accurately capture an actor’s 
motion and optimize 3D Effect of the motion capture.
1.	 Yaw: Direction settings. This parameter is used for adjusting model 

direction. The default value is 0. The clockwise direction is positive and the 
counterclockwise direction is negative. The range is -180 degrees to +180 
degrees.

2.	 Pitch: This parameter is the included angle between the sensor and the 
ground in vertical direction. Front is postive and back is negative. The range 
is -45 degrees to +45 degrees.

a) Application: Optimizes the contact effect. After posture calibration the 
contact effect may be inaccurate. So you can use Pitch to adjust the 
model’s posture. 

3.	 Roll: This parameter is the included angle between the sensor and the ground 
in a horizontal direction. Rightward is positive and leftward is negative. The 
range is -45 degrees to +45 degrees.

TIPS

•	 After you’ve completed the 4-step posture cal-
ibration, if the model in the viewport still has di-
rectional issues or problems with the position of 
the angle, then you can adjust Pitch and Roll to 
correct the posture.
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6.2 Body Size Manager
Adjusting the body size for you avatar inside of Axis Neuron can improve the data 
accuracy of the motion data. In the Body Size Manager, you can create, store, 
import, export or edit the body size data. There are some default body size files 
in Help-> Open Folder-> Body Size. Choose from one of the available presets 
or manually input an accurate body size measurement. For real-time capturing, 
you should choose a body size that matches the actor’s real size before posture 
calibration.

Some Common Issues:
•	 If the model always has front-back incline after calibration, adjust the pitch 

before recording. (Human shape and posture problem). 

•	 Carefully spend time perfecting the posture calibration before recording, this 
will save you time in post editing. 
 

Operation Examples:
•	 If the model leans back and the feet are not contacting the ground when 

walking forward. 
Solution: increase the Pitch value to make the model incline forward.

•	 If the model leans forward when the actor walks backwards and the feet 
have difficulty contacting the ground.
Solution: decrease the Pitch value to make the model incline backward.

•	 If the model leans right and the left foot is not contacting the ground. 
Solution: decrease the Roll value.

•	 If the model leans left and the right foot is not contacting the ground.
Solution: increase the Roll value.
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1.   Measure the actor’s dimensions in centimeters: 
Reference 6.7 Body Size Measure.

2.   Click Add Body Size.

3.   Name the new body size. Then input the bone data that you just measured.
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Additional:
•	 The body size of the model can be changed during playback review of the 

recorded file, however, this operation is not suggested. You will get better 
results by establishing proper body size setting prior to performing the 
posture calibration.

•	 If you change the Body Size after your initial posture calibration then you will 
need to calibrate again.

•	 Import Body Size: Click         in Body Size Manager. You can import the existing 
Body Size file into Axis Neuron for use, however, the Body Size format needs 
to match the existing format for optimum accuracy.

•	 Export Body Size: Click   	  in Body Size Manager to export a Body Size for 
later use.

4.   After establishing real-time connection, the default body size is Male 170.

5.   Click Body Dimension in the Sensor Map. Then choose the body size that you 
just made.
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6.3 Parameters

1. Joint stiffness: The Default value is set to 0.65, setting a higher value will make 
the jointed bodies much more difficult to seperate. If the Body Size is accurate, 
you can adjust the value much higher, however, if the Body Size is not accurate, 
lowering this value can add some leeway.

2. Step stiffness: When the model is walking, the system will use a pattern 
recognition algorithm to determine the contact between the feet and ground. The 
step stiffness value affects the speed of this status change. Larger values will 
plant the feet more firmly on the ground. Conversely, smaller values will allow the 
feet to slide easily while contacting the ground.
 
3. Step constraint: The contact sensitivity between feet and ground. The higher 
the value, the more likely the feet are to contact the ground. The smaller the 
value, the less likely the feet are to contact the floor. For example, if the actor’s 
feet are 0.5 cm higher than the floor, when the factor is 0.2, Axis Neuron may 
not consider the feet to have a step on the floor, but when the factor is 0.4, Axis 
Neuron may already consider the actor’s feet have a step on the floor. 

4. Anti-Mag: If there are high magnetic fields present, the feet may experience 
rotational drift. Check this box to minimize this result.

5. Ground constraint: Check this when parts of the actor’s body are contacting 
the ground.

6. Ground height: This parameter is used to avoid the skeleton from penetrating 
into the ground when the actor goes upstairs or downstairs.  
   
7. Foot lock: Enable this option if you are not satisfied with the Step stiffness 
effect. When the algorithm determines that the feet are contacting the ground, 
the displacement of the Z direction will be locked which can facilitate the feet 
becoming stuck on the ground.
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8. Contact points: Can be applied to the feet, hands, or hips.

•	 Feet contact: Ten contact points: 5 at Ball of the foot and 5 at the back of 
the foot. 

•	 Hands contact: Contact points are at palm.
•	 Hip contact: Contact points are at the caudal vertebrae.

•	 Hip height: The height from the hip to the ground.
•	 CoM acc threshold: The default value is 0.8g. This is a threshold value. This 

value judges whether the body is contacting the ground based on the body’s 
center of gravity.

TIPS
When the motion requires the feet to leave the ground, 
you need to uncheck the Feet contact points, then apply 
the Hip contact points. Set an appropriate fixed height 
for the Hip. Only posture is captured in this kind of 
condition, no displacement (translation of the skeleton). 
If you need a result that has both Feet and Hip contact 
posture, you can check Hip Contact and then uncheck 
Feet Contact. Then choose the interval for the hip 
contact and click Recalculate Selected Frame.
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6.4 Smooth Factor
Usually, there are factors that influence the accelerated speed and acceleration 
of gravity when an actor wears the equipment sensors:
•	 Body shaking (yourself or some external factor).
•	 Sensor measurement error.
•	 Straps slack (straps and body have relative displacement).

Those effects can be countered by the Smooth Factor function.

1.   Open .raw file.
2.   Check Enable in Smooth Factor.

3.   After you change the value in Smooth Factor settings, click Apply button.

(Calculate the average hip displacement value of adjacent 5 frames).

4.   Export the data.
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6.5 Data Visualizer

Visualize real-time-changing displacement and angle data for the body in the 
Data Visualizer panel.

Operations:

1.	 Choose the data type. 
 

2.	 Set the Curve mode.

3.	 Choose the joints you want to visualize. 
 

4.	 Choose the displacement or angle in plotting properties. 
 

5.	 Play the raw file, you can check the real-time data’s change.
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6.6 Contact Editing

The Perception Neuron system has an abundance of optimized algorithms. You 
can use them to achieve an ideal contact result. You can adjust the effect by 
single frames or by interval frame values.

Caution:
•	 Once you start contact editing, do not adjust the following parameters, 

otherwise the previous contact editing operations will be invalid.
a) Model Alignment: Yaw, Pitch, Roll.
b) Parameters: Joint stiffness, Step stiffness, Step constraint, Contact points.

•	 When you are editing the Nth frame, it will influence all frames after N. But it 
won’t influence the frames before N. Avoid editing frames that come before 
any edited frame.

1.   System auto optimization - There are 10 levels of optimization, the default           	
      value is 2. When you turn it to 0, the system will cancel optimization.

a) If you didn’t change the status of optimization, the status will default to 
a value of 2. (The auto optimization will take effect before you open the raw 
file.) If you change the value after you open a raw file, you need to recalculate 
all frames. (Right-click Contact Editing module, then click Recalculate all 
frames.)

2.   Contact Editing Window

•	 Black means the body is touching the ground, if the frame is grey it means 
the body is not touching.

•	 L Hand: Left hand contact editing area.
•	 R Hand: Right hand contact editing area.
•	 L Foot: Left foot contact editing area.
•	 R Foot: Right foot contact editing area.
•	 Hip: Hip contact editing area.
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•	 When the red ball on the ankles display, this indicates the foot is touching 
the ground. When you are editing contact status, you need to check Feet 
Contact point.

3.   Single frame editing
Eg: Make the 1539 frame right foot status from uncontacting to contacting.
Method 1: Right click 1539 frame and choose Contact.
Method 2: Use shortcut key. Move the pointer to 1539 frame and click W.
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4.   Interval frame editing
a) E.g. Change the interval frame’s right foot status from uncontacting to 
contacting.
b) Right-mouse drag the frames area you want to modify, then click Contact.

Caution:
This operation has no shortcut keys.

TIPS
•	 When you are contact editing, you can 

widen the contact editing panel to alleviate 
errors. When you locate a frame you want to 
edit, you need to make sure that the pointer 
is still located at the frame you want to edit 
after you right-click.

Data Editing



AXISNEURONUSERGUIDE

64

5.   Combine Step stiffness to optimize feet contacting.
Precondition: Contact Optimization Level is default value: 2.

Steps:	
•	 Open .raw file.
•	 Adjust step stiffness. Keep in mind that this step must be completed ahead of 

manually adjusting contact status. Reference in 6.3 Parameters.
•	 Recalculate all frames in the contact editing panel.
•	 Then you can adjust contact status of any frame and you don’t need to 

recalculate.
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The closer the Body Size data is to the actor’s body size in Axis Neuron, the more accurate 
the motion capture data will be. You can add a new body size in the Body Size Manager. Then 
input the values you measure. 
Tips:  the unit of measurement is in centimeters.

1.	 Head 
Top of head to the line of upper lip and earlobe.

6.7 Body Size Measure

Top of the Head

The line from the ear 
to upper lip

Top of the head to the line of
upper lip and earlobe
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2.	 Neck
Line of upper lip and earlobe to C7 (the 7th bone of the spine). 

3.	 Body
C7 to head of femur.

The line from the ear 
to upper lip.

C7 (7th Cervical Vertebrae)

C7

Head of femur.
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4.	 Shoulder Width
Left rotation center of shoulder to right rotation center of shoulder.

5.	 Upper Arm
Rotation center of shoulders to rotation center of elbow.

Right arm
rotation point

Left arm
rotation point

Rotation center of shoulders

Rotation center of the elbow.
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6.	 Forearm
Rotation center of elbow to rotation center of wrist.

7.	 Palm
Rotation center of wrist to the top of middle finger.

Rotation center of the elbow.

Rotation center of the wrist.

Rotation center of wrist.

End point of middle finger.
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8.	 Hip Width
Left head of femur to right head of femur.

9.	 Upper Leg
Head of femur to rotation center of knee.

Left head of femur 
to the right head of 
femur.

Head of femur. 

Rotation center of 
knee.
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10.	  Lower Leg
Rotation center of knee to ankle bump bones.

11.   Heel Height
Ankle to the ground. (If wearing shoes, this measurement is to the bottom 

of the shoes.)

Rotation center of the 
knee

Ankle bump bone 
(lateral malleolus)

Ankle

Floor
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Offline Recording and Prop Function

Perception Neuron supports a new way to record eliminating the need for a 
router, computer and the AXIS NEURON software application. The offline data 
can be imported to AXIS NEURON from an SD card connected directly to the 
Perception Neuron Hub.

Offline 
Recording and 
Prop Function

7.
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7.1 Offline Recording
A portable USB power bank and a micro SD card will be needed for offline 
recording. The power bank will power the Hub and the micro SD can be used to 
store the motion data locally.

1.   Connecting a power bank to the power port of the Hub will enable offline 
mode.
2.    When offline mode is activated, the Hub will sound off two buzz alert tones. 
(One single tone indicates normal mode.)
3.   The HUB LED will stay on when the file system of the SD card is not FAT32.
4.   The HUB LED will stay on when the SD card is full.
5.   The HUB LED will stay on if the SD card is removed in offline mode, until the 
SD and Power Bank are reconnected.

7.1.1 Status Definition

7.1.2 Activate Offline Mode
Press and hold the red button on the Hub and connect the Power Bank to activate 
Offline Mode. Release the red button immediately after the Hub powers up. The 
Hub will then sound off two alert tones indicating the device is now in offline 
mode.

Power

SD card slot
Power supply
port 5v/2A
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7.1.3 Calibrate and Record

1.   Calibration 
Once offline mode has been activated, press and hold the red button 
once more, release the red button after the alert tone stops.
(3 slow beeps means to prepare for posture calibration, 10 beeps 
means calibrating.) 
The posture calibration has four stages that follow consecutively.
-STEADY POSE
-A POSE 
-T POSE
-S POSE

STEADY POSE: body keeps still until the rushing sound finishes.
A, T, S POSE: Three slow “beeps” means to prepare for calibration. 
(Please take the corresponding actions.) When the beeping sound is 
rapid, please keep the posture still. The Perception Neuron LED will 
remain flashing at 1Hz.

2.   Record
After the posture calibration has been completed, the Perception Neuron suit 
will begin to record immediately. All motion data during this time will be recorded 
locally onto the micro SD card.

There are two ways to Stop Recording:
1.   Unplug the Power Bank.
2.   Press and hold the black button.

7.1.4 Stop Recording
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7.2 Offline Data Import
All offline data will be stored in the micro SD card as a .bin file format. Axis Neuron 
will allow you to convert the .bin files to a .raw file format for playback and review.

Steps:
1.	 Open Axis Neuron and insert the micro SD card into the card reader on the 

Hub. Connect the Hub directly to a computer via USB.
2.	 Inside Axis Neuron, click File > Import. 

3.    Choose the directory.
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5.   Set the body size.

4.   Click Next after you choose the file you wish to import.
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6.   Set the working mode.

7.   Choose the directory to save the .raw file.

9.   Open the newly created .raw file  located in the directory that it was saved to. 
You may now playback your capture and edit the file as you wish. 

8.   Click import.

Caution: Prop Function is not supported in offline mode.
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7.3 Prop Funtion

The Prop Function is designed to help users capture and create added elements 
into the motion capture data. While recording, the user is able to hold the prop 
sensor or bind the sensor onto an object (e.g. a stick to simulate a sword, knife, 
etc.)

Contact point: This is defined as the center rotation of the  prop. The prop sensor 
may rotate around the contact point.

Operations:
a. Connect the prop tool cable with a Perception Neuron sensor to a spare socket 
on the body strap, this sensor will now become a prop sensor. Prop sensor function 
will only work in full body mode. When the prop sensor has been connected and 
detected by Axis Neuron, the Prop Settings panel will be enabled.
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b. Select the parent location of prop from the drop-down list of Props binding. 
By default, the prop tool will bind to the RightHand bone, you may click apply. In 
the Viewport, a 3D cube will now display on the parented bone that was selected, 
representing the prop.

c. In the Adjust contact point section, the Show manipulation checkbox will 
display the Manipulator of the contact point controller if selected. The contact 
point is located at the center of cone’s bottom surface.
The prop’s position should be on the blue ray that is perpendicular to the bottom 
surface of the cone.
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Then you can adjust the spatial position of the contact point by left/right drag-
ging an axis of the manipulator (axis selected will turn yellow).

d. In the Adjust props geometry section, activate the Show manipulator checkbox 
to show the manipulator of the Prop controller inside of the viewport.
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e. Select one surface of the Prop manipulator, then press and hold the left mouse 
button to move the spatial position of the prop, If the green corner of the Prop 
manipulator is selected, the user can scale the prop and select the axis that can 
rotate the prop (when the border line/green corner/ring is selected, it will turn 
yellow).
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f. Select Apply in order to save all the changes that have been made.

g. Click remove if you would like to remove the prop tool all together.
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File	 Export & 
Data 
Transmission

8.
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File Export and Data Transmission

8.1 File Export

8.1.1 BVH File Export

8.1.2 FBX File Export

Axis Neuron can export in BVH and FBX file format. Any software applications 
capable of reading these file formats can utilize motion capture data recorded 
through Axis Neuron.

1.	 Open a .raw file.
2.	 Click Export in the File menu.
3.	 On the File Type option, select BVH format inside of the 

Export Settings dialogue.
4.	 Click Export.

1.	 Open a .raw file.
2.	 Click Export in File menu.
3.	 On the File Type option, select FBX format inside of the 

Export Settings dialogue.
4.	 Click Export.
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8.1.3 3ds Max Biped File Export

8.1.4 Calculation File Export
Axis Neuron can export calculation file data. This data type includes bone posture 
quaternion in bone coordinate; displacement, speed in ground coordinate; 
original acceleration, and gyro data in module coordinate.

1.	 Open .raw file.
2.	 Click Export in File menu.
3.	 On the File Type option, select 3ds max Biped.
4.	 Click Export.

1.	 Open .raw file.
2.	 Click Export in the File menu.
3.	 On the File Type option, select Calculation.
4.	 Click Export.
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8.1.5 Processed BVH File Export

1.	 Open .raw file.
2.	 Click Export in File menu.
3.	 On the File Type option, select Processed BVH.
4.	 If you need a T-pose at the first frame or tail frame, you can choose this in the  

Add T-Pose option.
5.	 Click Export.

TIPS

•	 Unavailable: No T-pose at the first frame and 
tail frame. 

•	 Head Frame: A T-Pose before the first frame. 

•	 Tail Frame: A T-Pose after the tail frame. 

•	 Head and Tail: Both T-Pose at the first frame 
and tail frame.
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8.1.6 Multi-Character File Export

8.2 Data Transmission
Choose the content you want to transfer in File –> Settings –> Broadcasting. Axis 
Neuron supports BVH, Action, and Calculation data formats.

1.	 Open .raw file.
2.	 Click Export in File menu.
3.	 Select the file type you want to export in Export Settings.
4.	 Choose which character you wish to export or all by selecting the checkbox.
5.	 Click Export.

We will introduce these three data formats and the internet protocol.
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8.2.1 BVH

1.   Advanced BVH 
The basic BVH data channel only supports simplex communication. There are 
found issues with original BVH format which include restrictions of information 
and no backward compatibility. Therefore we defined a new format based on 
Google’s Protobuf protocol, Advanced BVH. This new format supports two-way 
communication and backward compatibility. 
We recommend you use this format. The definition of Protobuf protocol part is 
as follows:

syntax=”proto2”;
option optimize_for = SPEED;
option cc_enable_arenas=false;
package AxisPlugs;
message BVH_VECTOR{
  required float X=1;
  required float Y=2;
  required float Z=3;
}
message BVH_JOIN{
  enum Channel  {
   Xposition=0;
   Yposition=1;
   Zposition=2;
   Xrotation=3;
   Yrotation=4;
   Zrotation=5;
  }
  required  string      joinName=1;
  repeated  Channel     Channels=2;
  required  BVH_VECTOR  Offset=3;
  optional  BVH_VECTOR  EndSite=4;
  repeated  BVH_JOIN    ChildJoin=5;
}
message BVH_FRAME{
  repeated  float   MotionData=1;
  optional  uint32  ActorTag=2;
  optional  string  ActorName=3;
}

message BVH_HEADER{
  required  BVH_JOIN  RootJoin  =1;
  optional  uint32    ActorTag  =2;
  optional  string    ActorName =3;
}

message TAG_MAP_STRING{
  map<uint32,string>  Map   = 1;
}
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If data is packed, we need to extract data and then analyze it with Protobuf. If 
the data is source data, you can analyze it directly. The packed data is in zip 
format. When another client connects with this channel, the Axis Neuron client 
will send a command of Notify_ActorList to inform of the actor’s number and 
other details. When another client connects with this channel, the Axis client will 
send BVH_FRAME uninterruptedly, BVH_HEADER needs requirement to send.

message ERROR_MESSAGE{
  required  uint32  ErrorCode=1;
  required  string  ErrorMsg=2;
}
message COMMAND{
  enum CommandType{
    Notify_Characterised      =1;
    Notify_Uncharacterised    =2;
    Notify_ActorsList         =3;
    Notify_Error              =5;
    Command_Query_BVH_Header  =6;
    Command_Query_ActorList   =7;
    Command_ZeroOutActor      =8;
  }
  required  CommandType     CmdType     =1;
  oneof Content{
    uint32          ActorTag    =2;
    TAG_MAP_STRING  ActorsList  =3;
    ERROR_MESSAGE   ErrorMsg    =4;
  }
}
message AXIS_PLUGIN_MESSAGE{
  enum MessageType{
    COMMAND =0;
    HEADER_DATA=1;
    FRAME_DATA=2;
  }
  required  MessageType Message = 1;
  oneof Content{
    BVH_HEADER  Header=2;
    BVH_FRAME   Frame=3;
    COMMAND     Command=4;
  }

Every frame data format::
{
		  uint32	 ------>start mark, 0x41414141 is source data, 0x43434343 is zipped 
data
		  uint32	 ------>the data length
		  data
	 }

File Export and Data Transmission



AXISNEURONUSERGUIDE

89

2. BVH
There are two formats: string or binary.
String is mainly used for backward compatibility. It is inefficient and the quantity 
of information is limited. We don’t suggest you use this format.
•	 The string format:
0 Avatar00 -17.80 99.86 -2.70 … ||
0 represent character’s index.
Avatar00 represents the character’s name. The rest is this frame’s data.
|| means the tail of one frame.

Every frame’s data format is obtained from BVH headers. The easiest way to get 
the BVH headers is to export a BVH file according to current settings. Then get 
every frame from the BVH headers.

•	 The binary format:
This will send binary streams directly. Every frame will have headers and body 
data. So far, there are 2 versions of the header:  1.0.0.3 and 1.1.0.0. You can 
check use old header to switch between different headers. Here are the header 
formats of two versions.

 // DataVersion: 1.0.0.3
    struct _tagBVH_PIPE_DATA_FRAME
    {
        NUINT16 BvhHeaderToken1; // Package start token: 0xDDFF
        DATA_VER DataVersion;    // Version of community data format. e.g.: 1.0.0.2
        NUINT32 DataCount;        // Values count, 180 for without disp data
        NINT32 WithDisp;         // With/out dispement
        NINT32 WithReference;    // With/out reference bone data at first
        NUINT32 AvatarIndex;      // Avatar index
        NUINT8 AvatarName [32];   // Avatar name
        NUINT32 Reserved1;        // Reserved, only enable this package has 64bytes 
length
        NUINT32 Reserved2;        // Reserved, only enable this package has 64bytes 
length
        NUINT16 BvhHeaderToken2; // Package end token: 0xEEFF
        NFLOAT vMotionData [0];
    };
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 // DataVersion: 1.1.0.0
    struct _tagBVH_PIPE_DATA_FRAME_EX
    {
        NUINT16 BvhHeaderToken1; // Package start token: 0xDDFF
        DATA_VER DataVersion;    // Version of community data format. e.g.: 1.0.0.2
        NUINT16 DataCount;        // Values count, 180 for without disp data
        NINT8   WithDisp;         // With/out dispement
        NINT8   WithReference;    // With/out reference bone data at first
        NUINT32 AvatarIndex;      // Avatar index
        NUINT8 AvatarName [32];   // Avatar name
        NUINT32 FrameIndex;
        NUINT32 Reserved;
        NUINT32 Reserved1;        // Reserved, only enable this package has 64bytes length
        NUINT32 Reserved2;        // Reserved, only enable this package has 64bytes length
        NUINT16 BvhHeaderToken2; // Package end token: 0xEEFF
        
        NFLOAT vMotionData [0];
};

   union DATA_VER
    {
        NUINT32 _VersionMask;
        struct
        {
            NUINT8 BuildNumb;     // Build number
            NUINT8 Revision;      // Revision number
            NUINT8 Minor;         // Subversion number
            NUINT8 Major;         // Major version number
        };
    };
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8.2.2 Action

This is a motion identification channel. This channel will have data only when 
motion paterns are triggered.

The definition of this format :

// Action Recognition data
typedef struct _ActionRecognitionData
{
    ActionRecognitionDataTypes DataType;    // Type of action
    int                        DataLength;  // Data length
    int                        TotalLength; // Total length
    void*                     DataPtr;     // Address of data, always be the next address 
of ‘DataPtr’
}ActionRecognitionData;

// Recognized action data types
typedef enum _ActionRecognitionDataTypes
{
    Action_SingleTapping,    // Hand single tapping
    Action_DoubleTapping,    // Hand double tapping
    Action_Fire,             // Fire
    Action_InwardFlipping,   // Hand in-ward flipping
    Action_OutwardFlipping,  // Hand out-ward flipping
    Action_MassVector,       // Vector data of center of gravity
    Action_SwingVector,      // Vector data of body swing
    Action_Unknown,          // Unknown type
}ActionRecognitionDataTypes;
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8.2.3 Calculation
This channel’s data is obtained from calculations. It has string and binary formats.

Eg: Body ID is 01 and body’s displacement(X)’s three channel(x,y, and z) 
description:  

•	 String format: bone ID-data type-data subtype

All the data types:
World coordinate displacement: X (X, Y, Z), unit is meter
World coordinate displacement: V (X, Y, Z), unit is meter per second.
World coordinate module’s posture data: Q (W, X, Y, Z).
Module coordinate accelerated speed: A  (X, Y, Z), unit is g.
Module coordinate accelerated speed: M  (X, Y, Z), unit is radian per second.
World coordinate displacement: X (X, Y, Z), unit is meter
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Bone mappings as follows:

01    Hips
02    RightUpLeg
03    RightLeg
04    RightFoot
05    LeftUpLeg
06    LeftLeg
07    LeftFoot
08    RightShoulder
09    RightArm
0A    RightForeArm
0B    RightHand
0C    LeftShoulder
0D    LeftArm
0E    LeftForeArm
0F    LeftHand
10    Head
11    Neck
12    Spine3
13    Spine2
14    Spine1
15    Spine

Binary format:
struct _tagQVX_PIPE_DATA_FRAME
    {
        NUINT16 HeaderToken1;     // Package start token: 0xDDFF
        DATA_VER DataVersion;    // Version of community data format. e.g.: 1.0.0.2
        NUINT32 DataCount;        // Values count
        NUINT32 AvatarIndex;      // Avatar index
        NUINT8 AvatarName[32];   // Avatar name
        NUINT32 Reserved1;        // Reserved, only enable this package has 64bytes length
        NUINT32 Reserved2;        // Reserved, only enable this package has 64bytes length
        NUINT32 Reserved3;        // Reserved, only enable this package has 64bytes length
        NUINT32 Reserved4;        // Reserved, only enable this package has 64bytes length
        NUINT16 HeaderToken2;     // Package end token: 0xEEFF
		  _tagQVX_MOTION_SEGMENT vMotionData [0];
  };
struct _tagQVX_MOTION_SEGMENT
    {
        NFLOAT displacement [3];
        NFLOAT velocity [3];
        NFLOAT quaternion [4];
        NFLOAT acceleration [3];
        NFLOAT gyroscope [3];
  };
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8.2.4 IP selected

Axis Neuron client uses TCP/UDP to send body motion data. It can be read on a 
local computer or any other computer via the internet.

1.   TCP
a) Select TCP in File –> Settings –> Broadcasting. Axis Neuron’s Host IP will now 
become the Host address.

b) Select transmission type, like BVH binary, and set the port.
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c) Click OK.

d) Open the third-party client, then input Axis Neuron’s Host IP in Server IP, then 

input the  port number, then click Connect.

e) After the connection has been established, open a .raw file in Axis Neuron. Any 

machine linked to this Host IP can now receive data from AXIS NEURON.
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b) Select UDP in File –> Settings –> Broadcasting. Choose 127.0.0.1 in Host 
Address.
c) Select data type, like BVH binary, set the port. Then click Add button, input 
127.0.0.1:8888 or 255.255.255.255:8888. Local computer must add Client IP 
address and inform a different port number with data channel.

2.   UDP
a) Local computer transmission.
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d) Click OK button.
e) Open another client, set the port to 8888.
f) Open raw file in Axis Neuron or build a real time connection with equipment.

3.   Transfer to another computer:
a) Select UDP in File –> Settings –> Broadcasting, choose Axis Neuron’s     
host IP but can’t be 127.0.0.1.
b) Choose the data type, like BVH binary, and set the port.
c) Click Add button, add another client’s address or input 255.255.255.255.

If the third-party’s client is not on the same computer with Axis Neuron, you can 
define the port number. Input the port number you defined in the address panel; 
if not, input behind the data type port number.

TIPS

•	 If Host Address is 192.168.2.50 the client 
address must also be 192.168.2.50
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a. Click OK.
b. Start another client, set the port in Axis Neuron.
c.  Build real time connection.

Port:7001

File Export and Data Transmission



AXISNEURONUSERGUIDE

99

Third-Party Software Support

Perception Neuron supports current creation softwares like Motionbuilder, 
Maya, and 3ds Max. Character models can be driven in real time through most 
of these applications. This chapter explains how to use these functions and the 
plugin installation process.

Third-Party 
Software 
Support

9.
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1.   Plugin install -Run MBPluginInstaller.exe.

2.   Axis Neuron Settings:

a) Launch Axis Neuron, build real time connection with equipment or open a valid 
.raw file.
b) In File -> Settings -> Broadcasting, check TCP and Advanced BVH format, 
than input the valid port.

c) Set displacement and Reference in Output Format.
d) Click OK.

Third-Party Software Support
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9.1 Autodesk Motion Builder
1.   Run Motion Builder. Click the Resources panel in the Asset Browser -> 
Devices, then drag Motion robot into the 3D scene.

2.   Input Axis Neuron host IP address and Advanced BVH using Port in Navigator 
parameters panel, then click Online. If the button changes to green, that means 
the connection has established successfully. The character’s name will show in 
the Source.

Third-Party Software Support



AXISNEURONUSERGUIDE

102

3.   Choose a character in Source Combo box.

4.   Create a bone model in Model binding.
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5.   Check Live. This time the actor in Motionbuilder’s 3D scene will be driven by 
the Axis Neuron actor.

6.   Click the Characterize button.

7.   Drag the Mia character from the Motionbuilder Tutorials into the 3D scene, 
then choose Mia and NoitomRobot as the Source in the control panel. The bones 
will drive the 3D Mia model.

8.   If you reset the Actor’s parameters in Axis Neuron, you need to click Request 
BVH Header button to recreate the bones.
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Using the Motionbuilder Plugin record function:

1.   Check Recording in plugin panel.

2.   Click Recorder.

3.   Click Overwrite.

TIPS
•	 When you use the Motionbuilder plugin record 

function, the model in Axis Neuron must be in 
real-time mode and the Broadcasting settings 
should remain the same as before.

Third-Party Software Support



AXISNEURONUSERGUIDE

105

4.   Click play button to start recording.

5.   After recording, click the stop button, then uncheck the live checkbox.

The Motionbuilder versions currently supported by Perception Neuron and Axis 
Neuron:

Autodesk Motion Builder 2012
Autodesk Motion Builder 2013
Autodesk Motion Builder 2014
Autodesk Motion Builder 2015
Autodesk Motion Builder 2016

6.   Click on the play button to playback your recorded animation.
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Equipment Maintenance

Equipment 
Maintenance

10.



AXISNEURONUSERGUIDE

107

Equipment Maintenance

Both the Hub and the Perception Neurons sensors firmware can be updated 
together using Axis Neuron, When the Hub and Neuron are upgraded together, 
the Hub will be upgraded first and then the Perception Neuron sensors will 
follow. There is also support for upgrading the Hub or Perception Neuron sensors 
independently. When the Hub does not connect to the Neuron client, a dialogue 
will display, just click Only HUB upgrade.

When either the Hub or Perception Neuron sensors need an upgrade, a red light 
indicator inside of the sensor map will display. A green light indicator on the 
sensor map indicates the firmware is up-to-date.

1.    Upgrading the Hub and Perception Neuron sensors together:
•	 Connect the Perception Neuron suit to the computer via USB.  

You must have the Hub connected to the computer through the Data port.
•	 Launch Axis Neuron, choose Upgrade in the tools menu.

10.1 Device Firmware Upgrade

•	 Click Connect in the Equipment list.
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•	 Click Yes.

TIPS

•	 If all the light indicators are green, this 
indicates that the firmware on the equipment 
does not need to be upgraded, you may 
close the window.

•	 Click the Upgrade button.
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•	 Axis Neuron will upgrade the Hub first, then it will upgrade the Perception 
Neuron devices. There will be a second beep after the Hub has upgraded 
succesfully. Then the Perception Neuron sensors that have the outdated 
firmware will begin to upgrade. There will be a tone indicator after each 
sensor has upgraded successfully, the corresponding light will then change 
to a green light indicator.

•	 Click Finish button.
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2.   Hub upgrade only:

•	 Connect Hub and computer with a USB. The USB cable must be connected 
to the Hub’s data port.

•	 Launch Axis Neuron, choose Upgrade in Tools menu. 
 
 
 
 
 
 

•	 Click Connect button in Equipment list.
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•	 Click Upgrade HUB Only button.
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After longterm use, the sensors might accumulate some calculation errors. This 
will cause posture problems such as drifting. To correct this, you can install 
the Perception Neuron Sensor into the Prop Cable, then go to Axis Neuron to 
calibrate.

1.   Calibrate sensor directly with the Prop Cable.
•	 Launch Axis Neuron. 
•	 Click Calibrate sensor in Tools menu.

10.2 Neuron Calibration
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•	 Place the sensor into the Prop tool socket and connect the pogo pin 
connector to the Hub. Then Click Next.

•	 Click Connect in Equipment list.
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•	 Steady Pose status.

•	 Click Next.
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•	 Click Next.

•	 After Steady pose, move the sensor. The model in the window will show the 
sensor’s posture. If the posture is drifting, this indicates that the sensor is 
magnetized and you need to calibrate the sensor. Click Next.

•	 Click OK.
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•	 Click OK

•	 There are two different kinds of techniques to choose from to calibrate the 
Perception Neuron sensor. Click on either image for a visual reference on the 
calibrating techniques.

e.g. Holding the Prop Tool cable with your hand and rotating the socket along 
all axes (x,y,z). Alternatively, you can hold the Prop Tool socket on the tip of your 
fingers and rotate the socket in -+x,y,z.
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•	 Click Next when the video is done.

•	 5 second countdown will begin. 
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•	 Begin rotating the sensor as demonstrated in the videos. A green point 
cloud will appear showing the collected data.

•	 When this process reaches 100 percent, the Hub will start buzzing. Click 
Next to end the calibration.
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•	 After calibration, you can check the posture of the sensor, otherwise you 
can perform the calibration again if you are not satisfied with the sensor’s 
posture. Click Next Sensor to restart calibration or start a new calibration for 
a different sensor.

2.   Calibrating sensor in real-time mode - The basic operation is the same as 
calibrating the sensor directly with the Prop Tool cable. When calibration is complete, 
there will be a dialogue asking you whether you want to go back to motion capture 
mode. If so, reconnect the capture device by clicking Yes.
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Appendix

Appendix
11.
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Appendix

1.   Storage of equipment
•	 The Perception Neuron Anti-Mag container is made of special antimagnetic 

silicon steel material. It keeps the sensors from becoming magnetized by the 
enviroment. Store the sensors into the container when doing long distance 
transfers, long term storage, or exposure to strong magnetic field enviroments. 

Keep away from the following devices when you are recording:

1.	 Electrical machine or generator (3 feet).
2.	 Any magnet or electrical magnet (3 feet).
3.	 Power box or high-tension line (6 feet).
4.	 Loudspeaker box, refrigerator, compressor, A/C Unit (3 feet).
5.	 Computer, keyboard, mouse, earphone, TV.

2.   Common questions
•	 After installing Axis Neuron by overwriting the previous version, the program 

failed to launch.

Solutions:
•	 Run Axis_Neuron_CLEAN.bat  to clean Noitom registry or do it manually. 

(Path in registry is HKEY_CURRENT_USER –> Software –> Noitom.)
•	 Delete high version raw file in Noitom\Axis Neuron\Motion Files for low version 

Axis Neuron system may not analysis high version raw file.
•	 Reinstall. Click Repair then install.
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3) When connecting the device to Axis Neuron, it always hints, “No sensor found,” 
and all the BLN is in standby status.

Solutions:
•	 If you are using Single Arm mode, the dual pogo pin cable may have a faulty 

connection. Please replace the dual pogo pin cable and try to reconnect. If 
the problem persists, please check all adjacent straps individually by using 
the upgrade window.

•	 In Full Body mode, use the dual pogo pin cable to replace the main line of 
connection from the left hip pogo pin cable. Establish a connection using a 
dual pogo pin cable from any of the shoulder’s pogo pin socket to the Hub. 
In Axis Neuron, reconnect to the Hub. If there is a successful connection then 
this means the main line of connection on the left hip pogo pin is faulty and 
has no contact. Once the Perception Neuron suit has been troubleshooted 
thoroughly and found to have a faulty Upper Body strap please contact 
customer service at contact@neuronmocap.com

•	 If you are connecting devices with Wireless mode, you could unplug the USB 
cable from 5V/2A port to power off then repower it. If the Hub LED is 5HZ 
flashing, click connect button in Equpment list. If the connect still fails, it 
might be Internet instability. Please change the router and try to reconnect. 

After upgrading firmware, some sensor LED’s mistakenly show 0.3HZ slow 
flashing status.

Solutions:
•	 Connect the sensor corresponding to the erroneous LED to Axis Neuron with 

the Single tools line. Force-upgrade its firmware in Tool -> Upgrade. Click 
Connect in Equipment list, then click Single Neuron Failed Safe Upgrade. If 
after upgrade the LED is in normal status, then this sensor can continue to  
be used. 

TIPS
•	 If not necessary, please do not use lower 

version of Axis Neuron to overwrite the 
higher version. And please backup the 
registry before you remove. 
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4. The fingers sensor is always disconnected in real-time and the LED changes to 
standby status in 31-Neuron Full Body Mode.

Solutions:
•	 Find a portable power source and connect the device to the 5V/2A port. 

(Laptops do not always provide sufficient power when more than 18 sensors 
are connected, for such cases we suggest using power bank as assistance.)

•	 Perception Neuron works in WIFI and USB mode. There are 2 mini USB ports 
on the Hub.

•	 For USB mode, use the upper port to link the Hub with your computer for 
data transmission and power supply. If more than 18 Neurons are used at 
one time, it is suggested to use the lower port for additional power supply by 
linking it with a USB power pack.

•	 For WIFI mode, use the lower USB port ONLY for power supply.  

Appendix



AXISNEURONUSERGUIDE

124

5. Capturing ascending motion.

STEPS:
•	 Measure the height of the stairs. When in real-time mode, set the Ground 

height to a specified value, then uncheck Ground constrain.

•	 When you playback this file, uncheck feet from Contact points.
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6. When performing posture calibration, the S-pose or T-pose couldn’t 
    be selected.

Solution:
Only the Lower body or Full body mode require S-pose  calibration. In that same 
regard, lower body mode does not require an A-pose calibration. If you need the 
motion of arms, please choose a corresponding mode.
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7.    Hardware LED indicator status.
•	 Sensor LED status:

•	 Hub LED status: 

TIPS

•	 You can find this information in the last two 
pages of Help -> Quick Start Guide.
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